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A\ CAUTION

Do not drink the liquids under any circumstances,
as they can cause vomiting and diarrhea.

Take care not to let the liquids come into contact
with your eyes or onto your skin,

otherwise inflammation can result.

A\ ACHTUNG

Bitte trinken Sie nicht die Flussigkeiten,

da die Gefahr von Erbrechen und

Durchfall besteht. Vermeiden Sie den Kontakt
der Flussigkeiten mit Augen und Haut,

sonst konnen diese gereizt werden.

/A ATTENTION

Ne pas avaler les liquides d'aucune maniére,

car ceci pourrait entrainer vomissements et diarrhée.|
Veuillez a ne pas laisser ces liquides étre en contact
avec les yeux ou la peau,

car ceci pourrait entrainer une inflammation.

/\ ATENCION

No tome los liquidos en cualquier caso,

como pueden causar vomitar y diarrea.

Tome el cuidado para no permitir que los liquidos
toquen los ojos ni en la piel,

de otro modo inflamacion puede resultar.

A\ ATTENZIONE

Non bere per nessun motivo i liquidi poiché
possono causare vomito e diarrea.

Evitare il contatto di questi liquidi con gli occhi e con
la pelle poiché potrebbero creare infiammazioni.

-
A\ WARNUNG
Teile in Bewegung.
gg Halten Sie Finger und andere
Korperteile auf Abstand.
ANBE /\ AVERTISSEMENT
[EEEEN Piéces mobiles dangereuses.
FPHEEDFRNE, Eloignez les doigts et autres
parties du corps.
NANEBES /\ADVERTENCIA
HEFEARIL B - Partes peligrosas en movimiento.
FHSRREFIE. Por favor, mantengase alejado.
/A\WARNING /A\AVVERTENZA
Hazardous moving parts. Attenzione parti in movimento.
Keep fingers and other body Tenere le dita e altre parti del
parts away. corpo lontane.
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/\ CAUTION

Moving platen, T-shirt tray and covers can cause bodiy injury. Keep hands off platen while printing.

Halten Sie die Hander von der Auflage wahrend es Druckvorganges

Druckplatte T-Shirt:Ablage und Abdeckngen konner Korperiche Verltzungen verursachn.

A\ ATTENTION

Déplacement du plateau, chargeur T-shirt et couvercle peut blesser le corps.
Garder les mains éloignées lors de [impression.

/\ ATENCION

Retire las manos de la placa durante la impresion

Moviendo la placa, la bandeja de camiseta y las cubiertas pueden causar una herida personal.

A\ ATTENZIONE

Tavoletta mobile, il ripiano perla T-shirt ed il carter potrebbero causare infortuni.
Tenere le mani lontane dalla tavoletta durante la stampa.

TSFURTY Y bLAEEN —EOBICFAESH, FHET B, IBPIITSFUNEFEMT L,
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A DANGER A GEFAHR

Hazardous voltage wil
cause injury. Tum off main| Bitte schalten sie den hauptschalter des blessures. Etei
switch and wait 5minutes | aus und warten sie 5 minuten, l'interrupteur et anendre 5

A DANGER

[before opening this cover. | bevor sie diese abdeckung dffnen. |minutes avantd'ouvrir le capot.

A RBR

MESERERS, 2FBRMG.
ETERIR 6 S E, BARRE.

A PELIGRO

Hochspannung verletzungsgefahr! [Un voltage non adapte provoque| Un voltaje inadecuado puede
indre provocar las heridas. Apagar el

Interruptor principal y esperar 5

minutos antes de abrir esta cubierta.

>PS<

— m—
/\ ATENCION
No se suba encima de la impresora.
A\ CAUTION A\ ATTENZIONE
Do not climb onto the printer. Non salire sulla stampante.
A ACHTUNG AFE
Niemals auf den Drucker steigen. AEOLCRORNCE,
A\ ATTENTION AEE
Ne montez pas sur limprimante. BOREER LR,

as shownin the ilustration.
haubid gezaigt zum anheben.
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A CAUTION

Do not drink the liquids under any circumstances, as they can cause
vomiting and diarrhea. Take care not to let the liquids come into contact
with your eyes or onto your skin, otherwise inflammation can result
Keep the liquids out of the reach of children.

A ACHTUNG

Bitte trinken Sie nicht die Flussigkeiten, da die Gefahr von Erbrechen und
Durchfall besteht. Vermeiden Sie den Kontakt der Flissigkeiten mit Augen
und Haut, sonst konnen diese gereizt werden. Halten Sie die Flussigkeiten
von Kindern fern.

A ATTENTION

Ne pas avaler les liquides d'aucune maniere, car ceci pourrait entrainer
vomissements et diarrhée. Veuillez & ne pas laisser ces liquides étre en
contact avec les yeux ou la peau, car ceci pourrat entrainer une
inflammation. Maintenez les liquides hors de portée des enfants.

A\ ATENCION

No tome [os liquidos en cualquier caso, como pueden causar vomitar y
diarrea. Tome el cuidado para no permitir que los liquidos toguen los ojos
ni en la piel, de otro modo inflamacion puede resultar. Mantenga los
liquidos fuera del alcance de nifios.

A ATTENZIONE

Non bere per nessun motivo i liquidi poiché possono causare vomito e
diarrea. Evitare il contatto di questi liquidi con gli occhi e con la pelle poiché

creare Conservare | liquidi lontano dalla portata
dei bambini.

W OS> TRRLT 1, B RRE
W Deposite in compliance with your local regulations.
W Gebrauchte es gemas 6rtlichen Richtlinien entsorgen.

W Jetez conformément a |a reglementation locale en vigueur.
Deseche siguiendo |a normativa local

Smaltire in conformita alle normative locali.

AFE

A\ CAUTION

m%ﬁ;\lﬁmﬂiilﬁﬁi, Lubricating grease may cause Inflammation to eye and skin.

LB &ulwﬁm Ti(‘rﬁi"' A’Eggwlam e Wear protective glasses and gloves.
iBE ANBE TAEETE. mgﬁﬁgg‘gﬂg.nm, Swallowmg grease can cause diarrhoea and vomiting.
GREASE BABVIE, EARA. Do not swallow.

A CAUTION

Do not drink the liquids under any circumstances,
as they can cause vomiting and diarrhea

Take care not to let the liquids come into contact with your eyes
or onto your skin, otherwise inflammation can result.

Keep the liquids out of the reach of children.

A ACHTUNG

Bitte trinken Sie nicht die Flissigkeiten, da die Gefahr von
Erbrechen und Durchfall besteht

Vermeiden Sie den Kontakt der Fliissigkeiten mit Augen und Haut,
sonst kdnnen diese gereizt werden.

Halten Sie die Fissigkeiten von Kindern fern.

A\ ATTENTION

Ne pas avaler les liquides daucune manire,
car ceci pourrait entrainer vomissements et diarrhée.

Veuillez & ne pas laisser ces liquides étre en contact avec les yeux ou la peau,
car ceci pourrait entrainer une inflammation.

Maintenez les liquides hors de portée des enfants.

A\ ATENCION

No tome los liquidos en cualquier caso, como pueden causar vomitar y diarrea
Tome el cuidado para no permitir que los liquidos toquen los ojos ni en la piel
de otro modo inflamacion puede resultar.

Mantenga los liquidos fuera del alcance de nifios.

A\ ATTENZIONE

Non bere per nessun molivo i liquidi poiché possono causare vomito e diarrea |
Evitare il contatto di questi liquidi con gli occhi e con la pelle poiché
potrebbero creare infiammazion:

Conservare i liquidi lontano dalla portata dei bambini.
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(4) [Page Size[iHTLA M E.

e [Size]: [Custom]

e [Width]: 355.6 =X
e [Height]: 406.4 =X
o FTEIRTIIE: YA

(%]
o CRTERANEEIRE ISR . EIRFRHER) 14%16 ARIIRGS . =7"5-4-1. I BEIRART >>P.82"
[ Document Options X
General
Page Size ® Page size Label presets

Layout Size and orientation
Background 2
Guidelines Sizef§ Custom il (™ ]
g Widthl 355.6 < | millimeters =

Rulers : =

Save

|| Apply size to current page only
+/| Show page border
Add Page Frame
Rendering resolution: ~ | dpi
Bleed: |4.0

|| Show bleed area

? Save as Default... oK Cancel
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BUBITENEHE (ARXP U1
P ARXP # 20Hs EUE B AT T BN B B 93T BN R A7
A2 ARXP ST AT ABEAT BA TR 1A o
o ALK EUREHE AT BN B S B — R A7
o HDIAIER: PC M USB f#fifi s ELAEFTEN.
(%]
o ARXP XffTirgmin g . tEFSek EUGEHR R N -
o ENF SR FAERI[Print to file]45 4 AT RETCIEHE i S RS A B e . VE(E T ERHLIRBNFE T Brother GTX
PRO FileOutput".
o MWNFHFER EE T BN ACE BRI ="6-6-2. MRLFHFRT KIESTEN SR >>P.143"
(1)  MEEA= R iESFile] >[Print].
(2) 4THFIColorbrst, HEATLLFRE.
e ik [Document color]
e  [Color conversions]: "Brother GTX PRO"E%"Brother GTX PRO FileOutput"
o [Color profile]: [sRGB IEC61966-2.1]
e [Rendering intent]: [Relative colorimetric]

Print X
General Color Composite Layout Prepress 1 Issue
Color: ® Composite
Separations
Settings: ® Document color
Color proof
Color conversions: Brother GTX pro FileQutput -
Color profile: sRGB IEC61966-2.1 v

| Preserve pure black

Rendering intent: Relative colorimetric -

0 The color settings and preview available in this dialog box are set for the Windows
Graphic device printer that you selected on the General tab.

? Print Preview | > Print Cancel || Apply

(3) FTH[Generallt52%, M[Printer] ik 4 H F"Brother GTX PRO FileOutput"”.
[2%]
o BHEERZRK[Printer]iX & " Brother GTX PRO ", $TENEME &% EFTEINL.
B8 E TR HI[Printer] i3 & 4"Brother GTX PRO FileOutput"ff, #TEN%E L ARXP U
(4) fE[Preferences] X EFTEIHIIRANFE Y . ="5-4. WEFTEIHLIKENFET >>P.80"
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(5) % F[Print]xHEHERI[OK]G, SEonbPL FAHEHE. AdiERA7]

[2%]
o AIRERTEEJ LB EIIA].
9 Brother GTX pro File OutputREAmE u] X
fi58E: MG_1404
=L 13/02/2020 15:06
E#RRT: 14x16
HEEE: ya+aeng
= 5
o 3
TENEdA: x 10
BERES: 400 %
HREHNES: off
HEMESRE: off
...
R 0.06 cc e =
BEHE: 0.20 cc 100% | ! : : i ! s00%
HER: 13k ' ' ’ ' : '
B8R 1 WHMYK | T BEskiR
i M HRE I - |

(6) FREIRIFAEINDCIFA] [RAFIARXP 3Cff

s FA SE R Hh B0 TR B A

(1) IZREH e, £ CorelDRAW H I AR SCf4"GT_Colors. xml"F1"GT_Tshirts. xml"{x47 2 PC .
(2) MEEAL %R Window] >[Color Palettes]>[Open Palette].

(3) EFEAFZ"GT_Colors.xml"FI"GT_Tshirts.xml".

(%]
o B/ HKS. Pantone BN EA LR A . 75 i I E A T ENERE AT BEAN A
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L2 2 Y NIAZ]
(1) MRk FE[Bitmaps]>[Convert To Bitmap].

(2) #[Color mode]i% & N[RGB Color].

[Z%]
o FEHEMMSBITEN, Ki[Anti-aliasing] ¥ R UAHERHILES -

Convert To Bitmap X

Resolution: ‘300 | v_; dpi

RGB Color (24-bit) -

Options
[v| Anti-aliasing
[¢| Transparent background

Uncompressed file size: 8.33 MB

7| ok || Cancel

(Z%]
o EMEMITELIBESTRIEHERHRIIAUT, [Page Layout] T th AT E2E ASettings from printer].
bt AR ST AE[Page Layout] A B B e FE AR o
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41+ ) RGB=255 £ A RGB=254

RGB=255 R NEI R, A5 RGB=255 HIER AN HH i 22
ITENET, i5i%$ RGB=255 [1I[X 8 ##: 5 RGB=254 .

B DL 5y B e

(1)  MSEEArhik[Effects])>[Adjust]>[Replace Colors].

(2) Aid[OId color]ft) FHis#., fr[Replace Colors]Hi% & & RGB=255.

Replace Colors X

Em— P

New color:
H=3

Options: | |RGB RGB 255
® 255
S 3
B |25
Lightne:

x

SFFFFFF

[h;—

| Preview

(3) HFEEER T [New color]i% & iy RGB=254,
(4) ‘¥4[Rangelix & N"1", rith[OKH&4H.

Replace Colors X

Difference Between Cols
Hue: e
Saturation: 0 -
Lightn o |2
Bong |

(%]
o KEMHEN, HRHALHIE NN RGB=254.
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5-3-2. {#F] Adobe Photoshop K}

i#ifid Photoshop #1447 LA T4k
o PhNE
T ARYE T BT LA T HRAE
o QIEEFTENEHE (ARXP (1)
o fHEHIAR
o f"RGB=255"% 1 A"RGB=254"

[Z%]
o BN CMYK R, did MSEEes ik Image]>[Mode]# el RGB 48 (sRGB). i#id st i][Image] >[Adjustments] P i)
SRR, SoE T EIRE R R I (5"5-4-9. W E R >>P.93") K.
o AHLHHEFEH Photoshop CC2020/CC2019. iffiid Photoshop CC2020 5t G RIHI [ »

B E
(1) Mk i%FE[Edit]>[Color Settings].

(2) [Color Settings]iHfTLL F X HE.

[Working Spaces]
e [RGB]: [sRGB IEC61966-2.1]

[Conversion Options]
e [Engine]: [Adobe(ACE)]
e [Intent]: [Relative Colorimetric]

[Color Management Policies]
e [RGB]: [Convert to Working RGB]
e [CMYK]: [Convertto Working CMYK]
e [Gray]: [Convertto Working Gray]
e  [Profile Mismatches]: &A1 [Ask When Opening]. i%&#1[Ask When Pasting]
e [Missing Profiles]: i£H1[Ask When Opening]

Color Settings X

ot Gain 15% g
ot Gain 15% Save...

Dot Gain 15% : ( nel images)

ensate for Scene-referred Profiles HESES

Gray

ng @ Ask When Pasting 2 Blend Tex

Description
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BIEITENEHE (ARXP U
PL ARXP &0 UG ER AN T B3 B B E T EDER R AF
A ARXP SCEFJG AT BAHEAT DL R B4
o A LUK UG AN T B BB — AN SR AT
o TWTLUREER: PC M USB 12k 8 B 4T EIL
(%]
o ARXP CHTCEGRIERIL. B EUGKCR AT A .
o I AL UES H[Print to fle]HE 4 T RETCIE R SO SO AL BRI R 4. AT ENYLBRSh R Brother GTX
PRO FileOutput".
o IR ERAATEIN LA S SR "6-6-2. ASFIFRR: AT ENSl >>P.143"

(1) MEEEAR R ESFile] >[Print]l. PC —fsiF HI4T ML A" Brother GTX PRO"E"Brother GTX PRO FileOutput"itf, HE
PR B A ERRURT
(2) BHATLLT A
e [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings X

Printer Setup
Printer Brother GTX-4 FileQutput

Copies: 1 Print Settings...

Layout: [ Fa

~ Color Management

Printer Profile:
Normal Printing

Rendering Intent:  Relative Colorimetric

»  Description

~ Position and Size

(3) M[Printer]+i%&F 344 H A "Brother GTX PRO FileOutput”,
(%]
o K[Printer]i% & A"Brother GTX PRO "I}, FTENEEAI%EEFTEIHL.
¥[Printer]i5 & A"Brother GTX PRO FileOutput"ftf, $TEIdE LA ARXP SCAHR-AE

(4) {E[Print Settings] % BT EINLIKEFLT . ="5-4. X EITEINLIKEIRESF >>P.80"
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(5) F% F[Print]f5 SR L FAHEHE . s[ORAE]
(%]
o TIRERREEJLAMENIIRTIE].

BF Brother GTX pro File OutputFEaEE ] x
H5E: IMG_1404 7.0
=EEEER 13/02/2020 15:06 "
EdRRT: 14x16
SR ¥e+aane

=t 5

i 3

FTERE: x10

aEAEE: 400 %
HEEHMNER: off
HENESHEGHD: off

. |
PEmE: 0.06 cc e >
BEnE: 0.20 cc 100% f————————— 600%
$IEQ: 13k .

BTE 1 W+CMYK  ~| T EE4dR

o | Hae N - |

(6) FREIIRAFAEINCAFA] [RAFIARXP SCf.
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A58 FH SE R A Hh R S A
(1) F=MEH 7R, F Photoshop HHIiE i SCH"GT_Colors_T.ase"frf7 % PC H.
(2) MSEEHAFPEEWindow] >[Swatches].
(3) HMHi=, HIFTFER.

Swatches

(%]

RGB=254

)] HKS. Pantone Zita b4 bR it . 75 M e AT Ete i A AT
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¥ RGB=255 &1ty RGB=254 i}

RGB=255 iRAINE . FlE RGB=255 I/ AN i 5 o

FTENA T, 15168 RGB=255 [#[X 1) ¥ )y RGB=254.

T DA T B e

(1) BT [Layer]>[New Adjustment Layer]>[Selective Color]f|i:# K2
(2) HABEHIELRE N 20%IH mi[OK].

ve Color 1

Use Previous Layer to Create Clipping Mask

Cancel

Color: E] MNone

Mode: Normal Opacity: 20|

(3) 7E[Selective Color]#HTLL N HE.
e [Colors]: [Whites]
o [Black]: 1%
e i%rh[Absolute]

F-Y

Relative O Absclut=

[Z%]
o UWIEATA, ¥ RGB=255 &ty RGB=254 [1]/71%, 1¥[Color mode]N[RGB Color](1[8 bit]i AT H .
e liT Photoshop ¥ RGB=255 # & A RGB=254 [{jzh{F 30" SolidWhite.atn"fESZ 4+ (57'5-5-2. K"RGB=255"& 1M
"RGB=254"({X Photoshop) >>P.96"RGB=255"#;#4"RGB=254"({X Photoshop) >>P.109"). > T-{#if1 771%, &2 Photoshop
.
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5-3-3. f#iF Adobe lllustrator i

THIEL Nustrator 447 DL N A
o PihNE
o FTIFECH

AR 75 AT L T
o BUEATEREIE (ARXP X
o [EHSAHEM A B R

[Z%]
o bR EUEBHEAESTENVEREN, EUGHER KGR, T ME—#RAE,
- JASIETER PC — B fs A AT DKL B N"Brother GTX PRO"EL"Brother GTX PRO FileOutput".
- jE;T"Brother GTX PRO FileOutput"+T ENHLUKEIFE R4 H SCpE i T afiiA .
o BB NCMYKIH, iE# K432\ Photoshop, i@id 3 Hi i () [Image] >[Mode] #4454 RGB 1. % (sRGB). 734+, i 2\ Photoshop
DA P g S BB T EPH LIRS AR P R G (='54-9. W EE R >>P.93") fikE4.
o AHLHHEEE llustrator CC2020/CC2019. @it llustrator CC2020 i B EonEi I -
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B E
(1) MR IEFR[Edit] >[Color Settings].
(2) A[More Options].

(3) TPt T B I R [OK].
e  [Settings]: [Custom]
[Working Spaces]
¢ [RGB]: [sRGB IEC61966-2.1]
[Color Management Policies]
e [RGB]: [Convert to Working Space]
e [CMYK]: [Convertto Working Space]
e [Profile Mismatches]: i%H[Ask When Opening]. i%H[Ask When Pasting]
e [Missing profiles]: %" [Ask When Opening]
[Conversion Options]
¢ [Engine]: [Adobe(ACE)]
e [Intent]: [Relative Colorimetric]

Color Settings

1s are not synchronized for consistent color. To

Load...

): sRGB IEC61966-2.1

CMYK: U.S. Web Coated (SWOP) v2

olicies
1GB: Convert to Working Space
YK: Convert to Working Space

hes: Ed Ask When Opening [ Ask When Pasting
;- M Ask When Opening

Conversion Options
Engine: Adobe (ACE)
Intent:  Relative Colorimetric

Use Black Point Compensation

Less Options
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ITHFAF

(1) BEB.
e [Width]: 355.6 =X
e [Height]: 406.4 =X
e  [Orientation]: %Al
o [Color mode]: [RGB]

(%]

o CRTEEANEEIRE RIS (5541, ERTARIT >>P.82" i ubRER] 14x16 FAR AR

More Settings

e: Untitled-1
rofile:  [Custom]

Us. :: 1

: [Custom]

355.6 mm Units: Millimeters

406.4 mm Orientation: m [&]

op om Left Right

B0
A
~

Bleed: Z 0 mm 0 mm C/ 0mm s 0mm
:| RGB
5:  High (300 ppi)

e: Default
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BUBITENEHE (ARXP U1
LA ARXP g 2t UG EAR AN T BN B A AR E T BN ORAT
A2 ARXP ST AT ABEAT BA TR 1A o
o ALK EUREHE AT BN B S B — R A7
o HDIAIER: PC M USB f#fifi s ELAEFTEN.
(%]
o ARXP HTRESEEIE . 1EF e BUEEHE (A e -
o ENF SR FAERI[Print to file]45 4 AT RETCIEHE i S RS A B e . VE(E T ERHLIRBNFE T Brother GTX
PRO FileOutput".
o MWNFHFER EE T BN ACE BRI ="6-6-2. MRLFHFRT KIESTEN SR >>P.143"
(1)  MSZHA2Ar ik EEFile]>[Print] >[Color Management].
(2) HATLLTEE.
o  [Document Profile]: [sRGB IEC61966-2.1]
e [Color Handling]: [Let lllustrator determine colors]

e  [Printer Profile]: [sRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: Custom

Printer: Brother GTX pro FileOutput

General

Marks and Bleed
Qutput

Graphics

Color Management et Tllustrator determine colors

Printer Profile: sRGB IEC61966-2.1

Rendering Intent: | Relative Colorimetric
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(3) MI[Printer]he 444t I "Brother GTX PRO FileOutput".

(%]

o Kf[Printer]i% & A"Brother GTX PRO "I}, FTENEEAI%EEFTEIHL.
#[Printer]i5% & A"Brother GTX PRO FileOutput'if, FTEIAE L ARXP SR

(4) 7E[Advanced] & BATENHLIRBIEE R . ="5-4. W BEITEINLIREIAES >>P.80"

| GE=9

o Adobe lllustrator i, &3S HIRE AT ENXTEAE P AOZRGK IS i B RAR R AT ETBCEHEHER B, ATRETCIA LR

BWEEGRSARE.

(5) H F[Print]5 Eon A IAHEHE. A [fRAT].

(%]
o TREFREJ LBl HIRTA .

W Brother GTX pro File OutpuFRSEE
H#Ha: MG_1404
Bl iE: 13/02/2020 15:06
ERR T 14x16
ik SE P+ onpg

= 5
B 3
$TENAT Bl x 10
HERER: 400 %
HAERHNER: off
HEHRERE: off
4.
HENE: 0.06 cc
BEWE: 0.20 cc
$TED: 13k
1#7F ELH

< >

100% f—————————— 600%
BRE 1 W+CMYK  >| [T BE#HER
vz N = |

(6) FREIRAFAEIDCIFA], [RAFIARXP SCft
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fs A SE A Hh AR R

(1) =M EH RN, B lustrator R HCCA"GT_Colors_T.ase"f#474 PC .
(2) MSEEHAFPEEWindow] >[Swatches].

(3) A=, & TH[Open Swatch Library],

(4) %&FF[Other Library].

Swatches

(5) 7E[Open]imi i ik 14 "GT_Colors_T.ase",
(%]
e iZfil 5 Photoshop Fil CoreDRAW A[i], FFEERRKITH LA Fi 4% .
B2, f#H] llustratorCC i, e AR I5ikE E bz, BRAUR BN AN AT EAE B R oR.
METERER ETNES, TSR]

GT_Colors. T Add to Swatches

Sort by Name
Sort by Kind
Show Find Field

Small Thumbnail View

44”!1

AVd 4 4 4

Medium Thumbnail View
Large Thumbnail View
Small List View
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5-4. WEITHNESET
[5%]

o GTXPRO #TEIHLIKENFE T K RGB=(255,255,255)1F A" B A" Ab#E, At v a8 . AREME A B G ssdT B pest B G USR5
W E AN RGB=(254,254,254).

o KRTHOHEBHINE WEESNABEFIMNIT (="5-3. AR >>P.62") BN AR .

(1) RSN REFFRHTEEER,  SoRIT eI AOF T BN B XA

== THEER X

wx/EE ETRE

[EARR=T: 1416 v PEEIGE
fi:lihE FE+asne v
B @B [@]=1-H: L ElF: 3
B amRE: % 3 & & 3 W B
v I | 5
1 2 3 4 5
B I I 3
FTEMAjE: | x1 EEEE 400%
[ & eeEm# TEN
(I BtasmiriTen I [ 30 4 ol il
$TENEPE @L): !
COaeeseedTen o 10 20 M 40 KD 50
OfIREASRE(EaTInERD
[C%ee8y B2 EEITED TEEiTHEE
.
el MR

(= ]|

80



QAT ENidls

©00000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000

(2) AT EIHLIRENRE Y H9T B i BN T REREA T TR B
sUH{PRANRE], ATRERE O], [ERRE] [RETE.

(%]
MRAELh SR R E NN, i s s E T AN .
FEXTEHE FOURIVY AL B 8. R2sibntast, EEHD.
KTHEWETH U, ESRUEHET.

Brother GTX pro SRS
BEOSHE
DiiBHEﬁ | grean (0,199,0)

JE T

B EEHER: @@EE

BEREHEIREERE: I
EFEiEE
0 10 20 30
taHE I
=E: I
RbkrE: I
PEPH

01 2 3 45678910

SER-..

0
.2

ENE

3

BEE

54 -3-2-1012 3 435

HE: I | 0
| I | 0
=0 i | 0
£ I I 0
[ & miTED

Fi&mm@ R ENE

HLH

(3) BLELHUA AEHE]

€=
M"GTX PRO File Viewer" 13771 ARXP 3445 ol SR AL B KA .
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5-4-1. HEEEEARRN

VNI TOANG R |1 i e S e N G )R TN
(%]
o BT SARIKHURAR Y .

BEEUH

Ao FH AR

R

[16x21] 16x21 [EHT

406.4 =Kx533.4 =X

[16x18] 16x18 JEHR

406.4 Z=Kx457.2 =K

[14x16] 14x16 Hohit

355.6 ££x406.4 =K

[10x12] 10x12 JEH#T

254.0 2K*x304.8 =K

[7x8] 7x8 iR

177.8 Z=£4%203.2 ZXK

e FTEDESIEI
SBx/Ee BXEE

FiRRT:

X

B

[ s TEN

Ll a&amirdTen 1
ITENERS Bl

OaesatadTen . 0
TENDS M)

OFEEssRe@eTnER

Cl#2e=0 R SEEITED

[EiRRT:

SR T EREIRIR T

16x21 (406.4x533.4mm)
16218 (406.4x457 2mm)
14x16 (355.6x406.4mm) =1TE
1012 (254 (304 8mm)
[7x8 (177.8x203.2mm)

2l 30 4 Al Gl
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5-4-2. EPEMBFR

AN R B s e T LS vies e LA MHE DA ERE

WEIH Tt
(o4 At aE] 1E A SR E FFT R AR .
(N ERENE=)| R A s, fTERARE.
(RGN TEAREGR () BATE R ARG,
[ R B 5g] PG RS, fTEEARIE.
= THEER
gxym=s ETQE
EIRRT: 1416 v R
Rk

B i 1 3 5
i I

[5
i | IER

ClaemsETEn

L B&5ITE 010 2w 30 4 % B
TENERR (5 ): L

Ooeaets®En 0 10 20 30 40 50 60
FTENERE () -

OfAEHEa(EeTInE R

O#zee m&IBEFTED | IREEEE

gé%ﬂ!ﬂ%ﬂ“ﬁi&

o+ BEhE: T O S HETE 1TEI'E,EEﬂo
A fhE: D{EARShE, 1T
ShE: FE R HTENS
i (SRS HE, ITENROES.
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5-4-3. EPEER

L S S | S RN ol 4 S VS B ko D DS R O U1l S NS s M S

(%]

MRAEBERIANFE,  SERh KRR ] RE AR,

e $TENEEIN

gx/Ee ETEE

EiRR T [14x16 v meE
gl o+ omne vl

L O il ® BEhEELR
BehEieE:

1 3 5 7 9 11 13

1 2 3 4 5

[5
i | [ 3

e [0 geud a0

[ S s TEN

Ll aesmiriTen -' 1020 0 4 5 B
{TENERS &L): I 20

OaefetadTen 10 20 30 40 50 &0

JTENERS @#): | 20
Ol FURE R & CRETIRE D
1378y 5 S B2ITED | mEtE

o5
B REEMNGSESE, MULHE SR,
1BE, RIEHE, THhsl TRl SBERFZE,
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5-4-4. WEHEMHE

R fcs5rivE 2 O B bvivk = i el ol S NGt ) [ (RS RN o) 1 PN | SRR i a el i) Par T E B

FatRES AR 1 TR SR M. | HTEEEMEEMA G SR HTHRE.

Aoy, FEIRGEEFTRY [AESRETH [REREA BT H Gl R,

= FIENEER

£F/EE BETEE

EiRRT: [14x16 v meE
g S 2=t v|

15t CFLES (@=1.3:t T

(348 5 S BR4TED | mEiEE

BEGEhE:
IEAE D RBR TR ROEHR R, TTRE L L
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B FT N
=)
MA[13]4 ik RGB=254 [ F1FE GREE). (E/CK, [l S .
(BB RFTHE RN, ATHEE[10]~[13],

R EE TR
[1] s 200%
[2] O SR 250%
[3] A 2 300%
[4] I B 350%
[3] {0 2 400%
[6] o s 5 450%
[7] A s 500%
[8] i 58 550%
[9] {0 S B 600%
[10] i 2 5 650%
[11] F R R 700%
[12] A O SRR 750%
[13] O 2 800%

(%]

o ARHE T MBEEMFAR, =GR EEBAR. RN EEREE, THUERR, EFRtEEH.
="5-5-6. {TEIRILK AR ERIZE >>P.99"

o MME[FDL: ]\ [ROMESHARITENRIBE, [FTEMRTE: I&[A s AR,

o [FDG: IBEMANDG]) [ROMESHAITEORF I, [FTENNE: [N[x1]. K AWEZAEE, SontTEN AR 4.

o SEPNMBIEFEEHURTATENEB NI GR . WA SRR IARIE.

MBI e FE R tuith SR 1 B i B
WEME Wi
[1]24[2] EHTHR R At Pl AR O)R.
[3] NN
ORI A G, KE, BEOERZENRG
[4] EHTAA, RO, ROSEHERE O, RGN
[5] FERS X DASMRIITA DX AR 1 i SR A TED
(%]

o  ITEHIEERARZE, HkEFRERKEME. ="5-5-6. FTHIEHRERZEMNERZE >>P9g"

AT EP

it R AR, ROIEITE AR R ER A,
(R, BRSUYIA A,

[(5%]

o (XML RAPHRE A GBI TLIE

o MIHEIER JREREOLE o B, a&sﬁuzmusﬁzto
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H &5 KATEN

A UHTE R, aIEL] T (8] haase M.

e MIFABFTENES — 2 A A REIF A THIEE — 2 F G R A,
ISR LTRSS — E SRR ], REANARFHLIRT R 0 7D
(251

o DR JRFRIR O R it S T DA

Hes | REAHETE

BEEITAATT BT — 1 it S8R B TAGTT EVRZ it S8 = (YA 1] o

QR B LA TENRT— A s Z R ), BN RIRALIN TRy 0 #5.

[Z%]

o NUMARER: ARG A GBI AT LILE.

o TN MAPEHRIN R

o ATEVNEURIMTTRESASE. JU, FTEIAGER, 5 R FTHREE.
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5-4-5. FARRNHRRFR: FRRM IR

s AR O+AGmE, SRFAEMIERE CRE T MEA)D JBESH.

FTENEE T A,
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6-6-2. AN FIREFFRIEITENEdE

CorelDRAW

(1) MEEHFRIEEEFile]>[Print].

(2) FTHF[Colortz2s, HATLAFXE.
e i%&[Document color]
e [Color conversions]: "Brother GTX PRO"=%"Brother GTX PRO FileOutput"
e [Color profile]: [sRGB IEC61966-2.1]
¢ [Rendering intent]: [Relative colorimetric]

Print X
General Color Compasite Layout Prepress 1 Issue
Color: ® Composite
Separations
Settings: ® Document color
Color proof
Color conversions: Brother GTX pro FileQutput =
Color profile: sRGB IEC61966-2.1 v

+| Preserve pure black

Rendering intent: Relative colerimetric hd

0 The color settings and preview available in this dialog box are set for the Windows
Graphic device printer that you selected on the General tab.

7 Print Preview | B Print Cancel Apply

(3) FTH[Generallt5%%, M[Printer]#i%$"Brother GTX PRO ",

(%]

o BHBRENZRI[Printer]i% & N"Brother GTX PRO "I, FTEN¥E KEEITEINL.

B8 E R R KI[Printer]i% & 5"Brother GTX PRO FileOutput"ff, #TEN%iE L ARXP SCAHRAE

(4) 1E[Preferences] X EFTEIHIIRANRET, 4% F[Print] iEHERI[OK] A IS T ENEHE .

(%]

o RTHTEWLIRSIFEF IR E T =54, ESTEINLIRSIFET >>P.80"

o BMEAAH[OK], FTEMHLIICVEIFARHTEN . #% NHTERHLIFT B ER A6 TE .
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Adobe Photoshop

(1)  MEHAFIEREFile] >[Print]. PC —&fd 1T EPPLA"Brother GTX PRO "¢"Brother GTX PRO FileOutput"f,
HERRBE BN
(2) HATLLTF®RE.
e [Color Handling]: [Printer Manages Colors]

¢ [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings X

Printer Setup

Printer Brother GTX-4 FileOutput

Print Settings...

Layout: [y

~  Color Management

Printer Profile:
Normal Printing

Rendering Intent:  Relative Colorimetric

Description

(3) M[Printer]*i%#£"Brother GTX PRO ".
[Z*%]
o 4[Printer]i% & /y"Brother GTX PRO "I, TENHE A& IEZEITEHL.
H[Printer] i3 & A"Brother GTX PRO FileOutput"fi, FTEI%E LA ARXP SCHHR-AT

(4) fE[Print Settings] T X BITEIWLIKAIAES?,  midi[Print 53X T EIEE -
(%]
o RTATHWIAIEFRIBLE % =54, BLETHNLIREIRET >>P.80"
o HflExiddi(Print], FTENHLICIETFUGITED. & FTEHLIHTEHEEITT 44T EN .
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Adobe lllustrator
(1) Mk rhi%$EFile] >[Print]>[Color Management].
(2) FHATLLTBES
o  [Document Profile]: [sRGB IEC61966-2.1]
e [Color Handling]: [Let lllustrator determine colors]

e  [Printer Profile]: [SRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: Custom

Printer: Brother GTX pro FleOutput

General

Marks and Bleed
Output
Graphics

Color Management

Printer Profile: sRGB IEC61966-2.1

nt: | Relative Colorimetric

(3) M[Printer]+i%&$E"Brother GTX PRO ",
(%]
o Kf[Printer]i% & A"Brother GTX PRO "itf, ITEN¥EAIEEITEIHL.
K [Printer] % & ~"Brother GTX PRO FileOutput"i}, FTENZHE L ARXP SCHARAE

(4) 7E[Advanced] i EFTEINLIRSIFET, s [Print] ZI&FT ENEURE .
[&5]
o RTATENUIRENERF IR E T E ="5-4. WEITEHLIESIFLR >>P.80"
o HNfEAT(Print], FTERNLBIETFAAFTED . % FHTEPHLAGHT EPEEITTU6TTER .
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6-6-3. I\ USB RS NFTENEHE (ARXP 3C14)

(1) K USB fififiastdi N4 R AR AT THI ) USB fEfifiastdi .
[H2]
o B RN USB ffikes. B, FRESHIR.
(%]
o fHAEZEN2 GB~32 GB LA, it FAT32 #% 30tk USB FEfkae. Joidfii 0 aishhe s 2 Thits AT 32GB
USB f7fiti#
o Y USB fAiARIE M ARXP %A1 ARX4 #%=IK%HE -

USB #4284 11

X0038

(2) M PR EDAE, JFE T @Y -
[5%]
o RS ESRHE R

SKER
ITEELES

FTEMMAE

EE TR
EOCE
2

(3) EHTENRSCIEA, T @ -
[5%]

o [ Ban [ ekt
o USBHEBMICHREREE 3 R, RERE 42U ORI,

< BN H < BRI
O Sample Foldert

[ Sample Folder? 5| = Sanple Folder?

= Sample Datal.arx4 — Sample Datal.arx4

72 Sample DataZ.arxp ‘ Sample Data2.arxp
Sample Data3.arxp Sample Data3.arxp
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() FATI T B a‘me@o

[E%]
o ITEMZHINMRIAIE, E20MAE USB f7##S. IR SRR FEEEIR.
(%]

o ARVEBGRMIAN, SEEATRET B L.
o VAL USB fAEgsNISCif. ="9-1. KAMERT >>P.232"
o HLIAEMHEIER . ="8-7. RNk E >>P216"

Sample Data

# 14 x 16 inch
¢ 5. 45cc

SHEIZENOK
FTEREHIIRN S
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6-71. FTEI13k

™

@)

BAATEN R

BASOWIRATENZHELINKR, BAGERE, FHEnsm, $TEHIA AT -
FEEIPON 2 7, TIEIE 2R I ARONT T B (K L AR RS
(%]

o BT HZAETAREBUT AR, A

o BT HZHIAFEBRT EHRIT, A R

BB RR AR T s B TED ORI, 42 T HT BT AT EN

FTENSERE, REHARRS iR e T A AL B, A

(%]

o JEHCRIFTEATHZINS, BIfEL NTEIZEH], QOB R AL RTIREE), TITaRITEN . E R RIE NTEMHZH.

. F @ JEATETE.

o {EEMBEACE 18CHHEET, HHAAMEITHN, FiESTHMENRTIT,
RIESSATIN,  FTEDASH AR TR AR L (o) FTREZS K, 28 RIRIS TR ERT, ="8-11. W EKIRA FI4TENZ)
& >>P.218"

o HIRAKIRHIEFEERT, FTRIERERAEPIT R TR K. BRSNS SEEG » BRI (R
SITEMRIEERE - ="11-1. 28 >>P.315"

6-7-2. ITENZIK

RAFATENEE, AIFTENZ 5K,
(%]

™

(2

DIWTEIRS s HEMER OR A7 KR -
M OBLEATEPHL 9 LA SHMERIT BN ] hade e DMBRI I, Serir e sKEUOAT NS, RHIMBRATEN SR . ARSI, THIRAR R 2
HiRH. =78-16. EMBRITEEEE >OP. 2217

FRATR A TR BB TP, 3% N AT O GaFTEr.

FIERTERYE, WM R mAEamara e, K s,

(%]

o JRMRCRMIHFIFESINT, BUERE FFTEMEAH, (CEE BRI aiFEs), TR Er. 15X T EEH.

o v () mre.

o VRATHIMR A ENTT ENHITRAL

o  EEWNEEAL 18CHIMET, M A@METEIN, STt (KiRZ1T.
(RIS ATIS, FTENRTRIFNFT ED el ZED i R T e AR . AR RIRIZATHOBE B R, ="8-11. W EARIEN FIFTENSh
£ >>p.218"

o ERGEHEAERE, FTRNSEHUERILER R iR K, B REANE NS S SRS - 1P B RSN R » (AT
EHTEIFAEHE - = 1-1. 8 >>P.315"

TEHHARAHTEN BT (T, EEITENE 2 e R 5K EL

148



6-7-3. MBCCRITED

FJ CAFT B 25 Bl 3 T N

(%]

o HEMSORAFIITENEMERZ Y 100 4>, Ftit 800MB, M F-HHT ENEE  FAamIER: .

o UIWTHIRE, RHMIERORATHORARE

o OBEITEMHL B [ A SMMERAT ENEe ] chade B BRI, TVEMEH RSOE R T ENThRE . ARSI ERY, TEIRIE TR I E.
="8-16. HEINMIERFTENESE >>P. 2217

(1) MSEE R EG LR T EI R A -
(%]
o IEREHT IR I BT BN -

(2) BB TR R BT BN, 4% N 3TN 464 TER
ITEDSERE, KEHARES SR FE T AT A L, A P
(%]
o IEBURIATHRTRSIN, BIEEL THTEMZH], (ORI RS TR, TTEITFAGITER. W RHAE N ITE AL

. HF @ S TEILH.

o TEEWIREAR 18CHIHEE T, i OGMERITER, AIaEatIitE KIS,
RIRIBATRS, FT BRI AT BN AT I 4Ed it Rl T e AR . AR RIS TR B R, ="8-11. B ERRA AIFTENS)
£ >>p.218"

o FRAEFEERS, FTHISHERIZEPITE TS K, BRREEEESEEG - EPURCHUREANE S (AT
SITENRIESER - ="11-1. 358 >>P.315"
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6-8. ITENTL

I RE M TEIHURAL TAHUIRAS, R rTIEId $ e % ST BN I T B, AR T BN A AT ST BRSNS, BRI TFA64TER .

6-8-1. TF]THZIFTENFIRTTE]

PRYHTEN R a] . TENS RSB, B ol sSsPE A SIa], T TEHZ T B DA T —4TED.
FTENGEAUEHCN T, et BSCESTi T A, RIMESEOR, FTEIHLEERET E—NMTEIR S HN, .
(%]

o WAMETENTERH) T MR EICT, KEESTENRT — T MUBCELERR b, 2RE% R AT e

o IHISHRIRMESATITEINUN, AREFGIZ FITENZAH].

IS 1] iR
YT BN A FTENHLETE USB ZR45/LAN £85Il T BNt vt
FTENJE i JE AL ) FTENTERET FIESUS, BEATHEL B0 BIBGEE. 1TEE B3GR EHER
H (i SRR BRRZISHE N A S AEFR LI 2, AEATEHUAAA A REAT B s 0 RIS

6-8-2. ITENFFUAHRTIE

FRAFTENA, FTENTHGIS B R R s

FRLIFT EIS 8] FTENTHARINS 8]
FlAT EP R ITEMSeE e
ITENE A AL E] GG B0 RIBGE . STEYS BB A AL B A i Se it
I i SRR H i SRR E e R

(%]
o TRAHTENEEHTENTFAAMIN], FTENZHIPOENKR.

6-8-3. LIEITUBITENHIIESL

KA BOUN, RS I e e
o JHUAITENRS, RAMRRET. (Biltn, BLE—JHTHE, bR D
o JHUGATEINS, FTEONLEBCATATEESE. (B, 3l [ A siMERITEN SR Thae, T IHERTT ENi (et
="8-16. HINMMBRFTENESE >>P. 2217)

6-8-4. EUHITEIFHA

TREFTEN R ZFTENTFAG ], ATIEIL 1% R HOH AR T BN Ly .

I ELh SRR FRAHT BN, SR 42 R EBOH A, R RIS B B i SR A A AT ENTRA) o
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6-9. MEARESFT

(1) ARFETEMRIE S, R ST
(%]
o ITEIEIMh SR, 152l
o T hiufibihsRnt, T EEERKER.
o T ARG LI R, IR ERE R R
(%]
o HITUMERARER, RULACHE T ML E 20T B AR (TR .

T il

X0114

151



SE S SR s 2B LR A -
o JRIML
I FEE MRS [ P PRLRT B8
o HUE
TTENSREE S, BEEfEE.
GEF=9
o IHFERFEE NI M E IS RIS . BRI, T s = .
(%]
o EMATEON, AIREH TURAREEE .,
o IHTIGIEE TS AR B K E ST o
ISR MT5 5 FT REFE 2T EN T L.
o WRAEAGERROHIRELIAEGHBCE LEERITENR, WATRES| LG,
URSR A I BEEAUR it S84 T EDAOST B AN (3 o S8 TENROFT BN, MR SRt
HHILGLEIS,  R{ F ARA B R R P R B A T B 5 15t
o IRIATUCEGHEAERERMSEH T 4il_E TR BRIy R FE T KIER.

MR R AR

IR AR BRI T SOARIE, g A% R P R AR AN TS o T RS R BN 2 ERUR R R TR

[(2%]

o RABBEHIOE OGRS, BRI, PR AR E ARG . 1555 R RS B B R R I
AL

o MRMETEINGL, WATREA SR, B P AARI PR
JEHFERIATAL B (M A S e £

o RN, TERIAMSRERACRAFIN PR ) .

o HMEHT TAMERTRAIRRIED TR, IBTEMIER I ST DU [FIRS HEACH 8] o

ol i INf i)
JERNL 180°C (356°F) 35 )
HEA FIRE 160°C (320°F) 3 %) 30 fb~5 4

T R T MRS, DU R IR R
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B ERLE MR
(1) RAEfsER. TAMPAR R EBOCE R R 2L EIF e,
[Z%]
o RTMSREMEAIRINE ='6-10. ERss >>P.152"
o HBIREREA RN AU .
o INFUEFIHER ARSI, WA TSR BCR M, SRR, WA TE B AR . HEARYE
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X0115
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X0116
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AR
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(9) £ SR I A ioh SR AR B PN PR FHSUIPR I 4K -

K 09. 2015
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S FH PR 4K

7-1-2. iEESEHAESTE
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RN SRIERF
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(3) HURRE. EEEE R, ST @ -
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o RSEEIRL, S HEHID .
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